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branch Book Swap. As he moves up from his post as the
wall street journal’s editorial features editor to
become an assistant managing editor—and into a cubicle
with fewer shelves—he contemplates what to do with the
3,000 books he has accumulated over the previous four
years there.
He says that when he was a young lad, a greybeard had
told him that “a cultured man should have very few friends
but very many books,” and that he has carried these words
of wisdom around with him ever since. His two and
a half friends can attest to his remaining true to the first
part of the sage’s dictum, and his wife can attest to his
remaining true to the second part. Varadarajan admits
that just as some people measure out their lives with coffee
spoons, he measures out his life with books left behind—in
Delhi, Oxford, London, and Madrid.
And if Walt Whitman had not said these words first,
Varadarajan’s wife certainly would have said them of his
books: “Wider and Wider they spread, expanding, always
expanding /Outward and outward and forever outward.”
Last year’s Book Swap was a success. May we have
a wider and ever-expanding selection of books to choose
from this year.

edition@editors.ca
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Program report

Income tax clinic for the self-employed
There were a few surprises at the February 26 general meeting.
The first was seeing Gillian Faulkner in the chair’s role, subbing
for Ken Weinberg.
by Grace Cherian and Noreen Shanahan

G

Peter Messaline,
tax preparer

4

illian did an excellent job, clearly

unperturbed by our new webcasting and
the increased audience as a result.
The next surprise—further news of
Gilda Mekler’s death—was a devastating reminder to many of the precariousness of our lives.
Lee d’Anjou spoke briefly about Gilda’s passing
and requested donations to help her family with
their needs. Gilda’s case was also a reminder to
take care of ourselves; she passed away in the wee
hours of the morning, having spent the night at
her computer on an editing assignment.
After tea, we were treated to Peter Messaline’s
entertaining and enlightening income tax clinic.
And this was a welcome surprise. Peter specializes in preparing tax returns for freelancers,
particularly for artists. He has been successfully doing this work for many years and has acquired a great deal of expertise, which he shared with us that evening. Peter is also a talented
member of Toronto’s cultural community, having worked as a performer for the past 40 years.
His Web site states: “I am a Canadian performer, tax preparer, and writer.” So combining his
two areas of expertise—and sometimes hamming it up for the webcam—Peter shared with
us some of the most efficient ways to keep tax records. Thank you, Peter, for an informative
and entertaining tax clinic. Thank you also to Gillian, for stepping in to fill Ken’s shoes, and
to Lee, for reminding us to pay attention to our health. The least we can do is reach into our
pockets and show support to our fellow editor Gilda. 

april 2007

Verse

Hin-Huﬄe hates a whose
Asked Ee-Dwee of the List one day,
“O List, is it correct to say,
‘A fruss whose bundle-thump is such
And such’ — or is there very much
To weigh against a use of whose
For antecedents that aren’t whos?
Should it begin ‘A fruss of which
The bundle-thump’ — or should we switch
To simpler whose despite the plain
Detail that frusses feel no pain?
“Inanimate or animate —
With pronoun whose, will either ﬁt?
If we for things dare use a whose
Would Thistle-Thwottle cry, ‘J’accuse!’?”
Quoth Kweedle from the Burr-Burr’s lore:
“To use of which is such a bore!
The genitive of who is ﬁne;
Such usage yields a smoother line.”
’Tis true that Burr-Burr in his book
A line from ‘Spangled Banner’ took:
Said he that when the poet wrote
Of stripes and stars, whose was the quote.
Declared Hin-Huﬄe to the List,
With stomping foot and clenching ﬁst,
“I cannot, will not, write that whose —
All other options would I choose!
“Of which is digniﬁed in style.
That’s what I favour by a mile.
The use of whose my taste does irk.
Allow me, please, my little quirk.”
Said Wump, with wagging ﬁnger long,
“Hin-Huﬄe, you are wrong, wrong, wrong!
The dictionaries all agree
It’s ﬁne this way. Why can’t you see?
Reprinted from Active Voice
March 2004 © Alan Yoshioka

Whose is the choice for proper style.
That’s what I favour by a mile.
Whatever Burr-Burr has to say
On whose, I’ll take that any day.”
Declared Hin-Huﬄe to the List,
With stomping foot and clenching ﬁst,
“I cannot, will not, write that whose—
All other options would I choose!
“Of which is digniﬁed in style.
That’s what I favour by a mile!
A whose for things ﬁlls me with hate —
Whatever Burr-Burr cares to state!!”
But mulling over Wump’s advice
She reconsidered once, twice, thrice.
She hemmed and hawed and wrestled long
With doubt: would giving in be wrong?
Would using whose just once begin
A chain of grave stylistic sin?
Where peers disdained an “ancient” taste,
Would holding out be just a waste?
Then spake Hin-Huﬄe to the List,
With rueful smile, her quirks dismissed:
“I sometimes will now write that whose —
Though sometimes not, just as I choose.
“I did so long pooh-pooh it, true!
But shall no more its use eschew.
My stiﬀ opinions I’ll now bend
And, thanks to you, my ways amend.”
And so here ends our tale of whose,
Of dialogue and changing views.
Attend, O Reader, to the List,
Whose wisdom can us all assist:
Though when we feel the critics’ touch,
At ﬁrst we might not like it much,
May we appreciate such mail,
And may the truth at last prevail. 
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Executive news

Nominating committee report
the toronto meeting on monday, april 23, will include

T

elections for next year’s branch executive. Both voting and qualifying EAC members can vote in the election. The meeting will take place,
as usual, at 7:30 pm at the Women’s Art Association, 23 Prince Arthur
Avenue, near Bloor and Avenue Road. A refreshment break and the regular program will follow.
Any EAC member can nominate himself or herself, or another member, at
any time, right up until the elections are held. Members may also co-chair
a position. All positions are open to any member, with the exception that
the branch chair and treasurer must be voting members. If there is more
than one candidate or candidate pair for a position, a secret ballot will be
held. If there is only one candidate for a position, that candidate will be
acclaimed.
The newly elected executive will take over from the current executive on
June 3 (the date of EAC’s national AGM). The election is for a one-year
term, but executive members are encouraged to run for a second term if
possible, to provide continuity on the executive.
The nominating committee, consisting of past chair jennie worden,
vice-chair gillian faulkner, branch co-chair alan yoshioka, and nonexecutive member carol hurst, is working to ensure that a full slate of
qualified candidates can be presented at the meeting. Before the meeting, the committee will also provide members with brief biographies of
candidates who have declared themselves.
Branch executive members are encouraged to attend all general and
executive meetings. Branch general meetings are held on the fourth
Monday of the month and executive meetings on the second Monday.
An overview of the executive positions and responsibilities is presented
below. The nominating committee is especially hoping to hear from members who are interested in the branch co-chair position.

april 2007

7

Executive news

Secretary
takes minutes at general and executive meetings and prepares them for
distribution
keeps and archives all reports submitted by executive members and
committees
creates and presents a monthly
report on hotline activity based on
information collected by the branch
administrator
writes the “From the Exec” column
for Edition, summarizing branch
executive meetings
draws up the schedule of executive
and general meetings for the year
This oft-undervalued position is a crucial
one. A secretary who takes accurate, succinct, and clear minutes provides a communications hub for the organization,
keeping the 90 per cent of our members
who are not at any given general meeting informed about what’s going on. He or
she also connects the executive with the
members and ensures links to both the
past and future, so that useful information
does not disappear into the mists of time.

8
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Treasurer
Note: The treasurer must be a voting
member of EAC.
monitors income and expenditures
(bookkeeping is done by the branch
administrator, with occasional help
from a professional bookkeeper; the
treasurer has a supervisory role)
reviews monthly bank statements
and financial reports prepared by the
bookkeeper
prepares end-of-year and mid-year
summaries for the executive
oversees the budget-setting process at the end of the fiscal year
(November/December)
arranges to change and update signatories to the branch’s accounts as
required
This position does not call for a mathematician or a bookkeeper, but for someone
with some organizational and business
savvy, a penchant for thinking about the
long term and the big picture, and a vast
reservoir of common sense. The main
activity consists of paying attention. The
main technical skill required is an ability
to make sense of simple financial statements—or a willingness to learn how (help
is available from past treasurers).

Executive news

Membership Chair
manages “door duty” at monthly
meetings (checks membership cards,
provides name badges, collects
fees from visitors), with the help of
volunteers
oversees Question and Answer sessions for new and prospective members before monthly meetings

Program Chair
plans, organizes, and publicizes
speakers or discussions for the
branch’s monthly meetings (nine
times a year)
looks after the needs of guest
speakers

recruits and trains volunteers for
both of the above tasks

together with the membership chair,
acts as liaison with the managers
of the meeting venue (currently the
Women’s Art Association)

organizes the EAC Toronto booth at
the Word on the Street festival (an
important venue for recruiting new
members)

arranges and publicizes the place for
pre-meeting member get-togethers
(currently dinner at the Duke of York
pub)

coordinates the branch’s new pilot
mentorship program

oversees the planning of any additional branch social or networking
events (for example, end-of-year
party)

tracks membership statistics and
makes them available to members
reviews and approves applications
for voting membership from Toronto
branch members
The membership chair rolls out the welcome mat for new members, and provides
information and organization for experienced ones. This position has the advantage of requiring a fairly predictable time
commitment, and it offers a great opportunity to work with a number of volunteers, both new and experienced.

Probably the most important thing we do
as an association is to help our members,
well, associate. In Toronto, we do this first
and foremost through our monthly branch
meetings, which now have a 25-year history as valued occasions for networking,
professional development, and plain old
fun. The person in this position sets the
tone and content for these meetings. The
program chair combines organizational
know-how with people skills to ensure the
meetings provide both information and
fun, meet our members’ needs, receive appropriate publicity, and run smoothly.
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Public Relations Chair
develops and implements public
relations campaigns, such as marketing strategies for professional
development and outreach to local industry-related organizations
and associations, with a team of
volunteers
co-ordinates with the national public
relations chair as necessary, and contributes to the work of the national
public relations committee
promotes the speakers’ program
acts as the contact person for branch
public relations queries
If you’re itching to blast the image of the
timid, self-effacing editor out of the water, this may be the job for you. More than
any other, the public relations portfolio
in this branch is BYOM—bring your own
mandate. This chair has responsibility
for promoting EAC and its members; but
which aspects are promoted, and how, is a
wide-open question waiting for a creative
but practical candidate to answer it.

10

april 2007

Newsletter Chair
nine times a year plans the newsletter content, ensuring it is accurate,
well written, and relevant to members
recruits, manages, and coaches a team
of volunteers
oversees the editorial and production
processes of the newsletter
copies the issue (in PDF format) to
the members’ area of the EAC Web
site (using the easy-to-use Content
Management System, or CMS)
copies the report on the previous
month’s program, or a suitable alternative article, to the public area of the
EAC Web site (also using the CMS)
prepares a monthly announcement
message that encourages readership
As required, the Newsletter Chair also provides accurate and timely responses to requests for advertising quotations, ensures
ads meet the agreed specifications, and
provides accurate billing information to the
branch administrator.
Editing a newsletter for editors—it’s either
a dream job or a terrifying concept; or perhaps it’s both? This meaty position provides
an incredible opportunity for on-the-job
training in a wide range of editorial and
management skills. It also serves a truly
crucial role in the organization; for our many
members who can’t or don’t attend meetings,
the newsletter is the primary connection to
branch activities and fellow branch members.

Executive news

Professional
Development Chair
plans and oversees the branch
seminar program, including content, finances, logistics, and publicity (day-to-day administration
and registration are handled by the
branch administrator, and many of
the other tasks are or can be handled by professional development
sub-committees; the Professional
Development Chair is at the helm)
resolves policy issues relating to
seminars
Since EAC Toronto’s widely admired program of high-quality seminars is not only a
major factor in the branch’s public reputation but the largest source of the branch’s
funding, the professional development
chair’s job is absolutely crucial to the organization. Because the task of running the
program is so large, professional development is the one area where the branch has
a standing committee to help with various
aspects, and a big part of the professional
development chair’s job is supervising this
committee and co-ordinating with the
branch administrator over daily developments. If you have a flair for business and
an interest in the education of editors, and
you are a master at delegating (or want to
learn how to be one), this could be the job
for you.

Vice-chair
advises and assists the branch chair
as necessary
runs executive or branch meetings in
the branch chair’s absence
helps other executive members to
recruit volunteer help as necessary,
facilitates branch volunteer appreciation presentations, and oversees the
ongoing volunteer database project
Vice-chair is a great job for someone who
likes people and is interested in how organizations work. A good vice-chair makes
the job of not only the branch chair but
also that of other executive members
easier, acting as a sounding board for ideas
and providing support wherever a project
needs a helping hand. You don’t have to be
interested in becoming chair in order to be
vice- chair—you just have to be interested
in EAC, and in helping to get things done.

april 2007

11

Executive news

Branch Chair
Note: The branch chair must be a voting
member of EAC.

chairs branch general meetings (currently held the fourth Monday of
every month except December, May
(Victoria Day), July, and August; the
June meeting is often replaced by a
party)
chairs monthly executive meetings
(currently held the second Monday
of every month except July and
August)
supervises the branch administrator
serves as the branch’s representative
on EAC’s National Executive Council
(if the position is held by co-chairs,
one is designated for this aspect of
the job)
provides general leadership for the
executive and the branch
The branch chair does whatever it takes
to keep the branch thriving. This means
mostly providing leadership: acting as
public spokesperson, making policy decisions as needed between meetings,
encouraging good communication and
decision-making at the executive, keeping
an eye on any ongoing issues, and working
with any parties necessary to resolve problems for the good of the branch. The job
changes from year to year—even minute
to minute—as circumstances change. The

12
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challenges are many, but the rewards of
steering such a successful and dynamic
group are extraordinary.

Past Chair
Note: This position is not open for election. It is automatically occupied by the
former branch chair whenever a new
branch chair takes office.
advises the executive and chair, providing continuity in leadership
heads the nominating committee for
branch elections (generally held in
April)
chairs any elections portion of a
meeting if the sitting chair is a candidate
oversees orientation for new executive members
Being past chair is sort of like being a
grandparent — you get to kibitz all you
want and don’t have to change any diapers.
Dispensing sage advice is the main activity, aside from asking endlessly “Are there
any further nominations?” during branch
elections, and answering many variations
on the question “why do we do it this way,
exactly?” However, after a suitable recovery period, past chairs also often end up
enjoying joining committees and helping
with other organization projects in ways
they did not have time for when sitting in
the big chair. 

Executive news

If you would like to declare a nomination before the
meeting, or would like more information about any
of the positions or about the executive in general,
feel free to contact any nominating committee
member.
Jennie Worden, Past Co-chair, toronto_br_past_chair@editors.ca
Alan Yoshioka, Branch Co-chair, toronto_br_chair@editors.ca
Gillian Faulkner, Vice-chair, toronto_br_vice-chair@editors.ca
Carol Hurst, Non-executive member, carol.hurst@editors.ca

april 2007
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Meeting schedule and new members information

Your Toronto branch

For your diary pages
Executive meeting

General meeting

Monday, April 9, 2007

Monday, April 23, 2007

6:30 p.m.

7:30 p.m. Business meeting

EAC ofﬁce, 27 Carlton Street, Suite 502

8:30 p.m. Program: Book Swap

All members welcome

23 Prince Arthur Avenue

RSVP: Ann Firth, 905 464-6373

Members free / non-members $5

toronto_br_secretary@editors.ca

Welcome! New members
As of March 1, 2007, the Toronto branch had 695 members (361 voting [includes 1 emeritus], 334 qualifying [formerly associate category]),
including 18 student members. Ten people joined in February, thirty
allowed their membership to lapse, and three members identiﬁed themselves as francophone. The new members are:
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Jennifer L. Charlton

Heather Ann Kaldeway

Steve Chorny

Lisa MacColl

Diane Cizek

Kate Rebecca Major

Marja Cope

Sharon McMillan

Eve R. Crandall

Daniel Naccarato

Mariah Hilton

Linda Sanderson
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Hotline report and registration

Hotline Report

March 2007

Members registered

13

Clients registered

2
Copy editing of a translated
biography
Copy editing of a manuscript of
“an artist’s life”

Both came by telephone

Hotline Registration
Clients call to be matched with branch members who
have registered with the Hotline for work.
When you register, please note these guidelines:
If you are listed in the EAC Directory of Editors
(print or online), note any changes to your listing.
If you are not listed in the Directory and have
not previously registered with the Hotline, send
your résumé in Directory or Hotline style. You
can find guidelines to the Directory format at
www.editors.ca/hire/ode/search_tips.html. Hotline
style follows the Directory format. However, you
may include as many interests as you wish and
write your profile in
point form.
Please limit your résumé to one page.
If you have registered before, send your résumé
only if it has changed.
Hotline registration begins on the first of each
month. Please contact the branch every month to be
listed again.
Telephone: 416 975–5528 Fax: 416 975–5596
toronto@editors.ca (.rtf attachment; subject: Hotline)

april 2007
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Professional development

April 2007 seminar calendar
8-step
editing

sun

April 2007
mon

tu

wed

th

fri

sat

1 2 3 4 5 6 7
8 9 10 11 12 13 14
15 16 17 18 19 20 21
22 23 24 25 26 27 28
29 30
Copy editing:
A Hands-on
Introduction—
Kathryn Dean

10:15 am to 5:15 pm

Copy editing:
A Hands-on
Introduction—
Kathryn Dean

10:15 am to 5:15 pm

Eight-Step Editing—
Kitchener
Mike Tanner
10 am to 5 pm

Scholarly Editing —
Rosemary Shipton
10 am to 4 pm

Developing a
House Style —
Elizabeth d’Anjou
1:00 to 4:30 pm
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April 2007 seminar calendar

Copy Editing: A Hands-on Introduction with Kathryn Dean—two-day seminar:
Wednesday, April 4, and Wednesday, April 11; 10:15 am to 5:15 pm. Copy
editing is a foundation skill for all editors. If you are considering becoming
an editor, or if your job involves editing, this workshop is for you.
Eight-Step Editing Kitchener Oﬀering with Mike Tanner—Saturday, April 14;
10 am to 5 pm. Eight-Step Editing focuses on editing a document for readability.
By mastering the eight steps, you will learn to improve a document quickly,
even under tight deadlines.
Scholarly Editing with Rosemary Shipton—Saturday, April 21; 10 am to 4 pm.
Scholarly editing is a specialized and surprisingly large area of publishing.
This seminar outlines what makes scholarly editing diﬀerent from other
areas. It will also show the rewards of this particular ﬁeld.
Developing a House Style with Elizabeth d’Anjou—Tuesday, April 24; 1:00
to 4:30 pm. Magazines, Web sites, brochures — if you create documents
of any kind, you need a style guide. In this workshop, you will learn how to
create a professional house style guide that suits your particular needs.
Treat yourself to an EAC seminar in April! To register, please visit our
Web page at www.editors.ca/branches/toronto/seminars or contact
the EAC Toronto Branch oﬃce at 416 975-5528.

april 2007
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Gilda Mekler: a memorial collage
Compiled by Alan Yoshioka, with information and photographs generously
provided by James Deahl, and with special thanks also to Avivah Wargon

Last month’s Edition brought a brief notice of the death of Gilda Mekler, a long-time EAC member,
who suﬀered a massive stroke on the night of February 6–7 while working late at her computer to
meet a deadline.



I met Gilda just once and liked her
right away. After that, we had contact
through e-mail on the EAC listserv
and sometimes oﬀ-list. She oﬀered
exceptionally sound—often inspiring—
editing advice and so much more.
Among all her messages, I can’t recall
one that didn’t reveal her nature: smart,
generous, talented, direct, witty, realistic,
compassionate. 
Carolyn Bishop

Dressed up for the wedding of her brother Rob





She was a giant, all ﬁve foot aught of her.

Society and was named the 1995
International Children’s Story Laureate
at the XVI World Congress of Poets in
Maebashi, Japan. 

Gilda was too wise for this world. Wisdom is
feminine in Jewish tradition; somehow I feel she was
inﬂuenced by this to become its personiﬁcation. I
see her standing, in a blue dress, moving her hands
as she makes some perfect point. But she was also
intensely creative. I recall the new carol she devised,
“The Twelve Days of an Editor’s Christmas,” back
when she was FEAC’s program chair and it was
Christmas. She wore a blue dress then; I have the
photograph. The ﬁrst day of twelve and eternal
refrain was “and an author who’d left for Hungary.”
Which had actually happened to her. She also
devised various games for us, in one of which she
tried to convince us that synecdoche was a city in
upstate New York. Her intelligence was so great, it
just kept overﬂowing, always in delightful ways. I
can imagine authors striving to please her.
Steve Roney
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Although many of us knew Gilda as

Gilda Mekler: a memorial collage



Mostly I think of Gilda as being comfortably and
supportively present, perhaps on the phone, perhaps in person
with a child or two. But memories are sharp and telling.

One evening, many years ago, Gilda and I arrived at a hall to
set up a FEAC meeting. Waiting for us was a new program
chair, who, we discovered, had brought no cookies and didn’t
know how to make coﬀee in a large urn. I was too surprised
to do more than put chairs in rows. But Gilda tactfully set up
the coﬀee, showing the other woman every step, including the
wait for the gurgle that tells it’s brewing.
A few years later, I had an assignment to copy edit a
community-college textbook. After discovering it was
untouched by a substantive editor and didn’t make much
sense, I met with the author and found him diﬃcult to
understand (English was not his ﬁrst or second language) and
almost impossible to keep to a point in discussion. I quickly
arranged for Gilda to work with me and brought her to the
next meeting.
At the author’s request, we met at his home in a dining room
lined with tanks full of tropical ﬁsh. Gilda went straight to
them, exclaiming at their beauty and asked many questions
about them. It took me an hour to realize that she had not
wasted time chatting; rather, she had established enough
rapport to get answers to our most urgent questions and to be
able to make intelligent guesses about many of the others.
Afterward, I complimented her on her style. “Well,” she said, “I
ﬁgured you wanted me to ﬁnd a way of getting home before
dawn. And looking
at ﬁsh was better
than distracting
him by saying
I have all-day
morning sickness.”
Oh, I miss Gilda.
If she had been
with me tonight
working on a piece
about someone
else, it would have
At home with her husband, poet James Deahl
been more ﬂuent
and funnier. And
when we ﬁnished, I would have made her a cup of tea (she
liked it weaker than anyone I’ve ever met) and told her two of
my daughters’ plans for weddings later in the year. She would
have giggled over idiosyncrasies, but would also have warned
me not to nag adult girls and assured me all would go well. 
Lee d’Anjou

At Shona’s baby naming

Date: Tue, 12 Jan 1999 10:42:02
+0000
Subject: EAC-ACR-L:CHAT: An
editor is...
To: eac-acr-l@list.web.net
My disrespectful daughter
offered me a capsule definition
of an editor. In context:
Me: Standing in the middle of
the room twirling a plastic
horse does not constitute
cleaning up the toys.
Daughter: It’s not a horse,
it’s a pegasus.
Me: Whatever.
Daughter (witheringly): And
you’re supposed to be an editor.
An editor is a person who
doesn’t say “whatever.”
Gilda

april 2007

19

Language

rammar food for thought
An editor’s observations on grammar and usage

Where have all
the men gone?
by Freya Godard

When I was scrutineering at the last but one federal election,
the deputy returning officer who was supervising the several
polling stations that were housed in the same large room
directed every newly arrived voter to the right polling station with the words “You vote over there where the woman
in green [or black or white] is sitting” or “You vote over there
where that gentleman is sitting at the table.”

I

found the pairing of woman and gentleman to be

fascinating and incongruous, if not offensive. In fact, I was on the
point of remonstrating with the supervisor when he must have
reconsidered his choice of words, because he began to say lady. It
would have been interesting to know what he was thinking and why
he changed his mind.
There was a time not long ago when the words used would have
been lady and gentleman, lady and man, or perhaps woman and man—
but never woman and gentleman. The use of these words has undergone many changes over the years and centuries, for various social
and historical reasons, but I especially attribute the reluctance to say
man to the influence of feminism. In the last 20 years we have all been
urged so often to strike from our vocabulary such words as chairman,
policeman, fireman, postman, and man in the sense of mankind that
it was perhaps inevitable that many people have begun to feel that the
word man is always unacceptable.
Even people who should know better can be heard to pause for a
split second when referring to a man and then say gentleman.
gentleman is also a word beloved by the police, who presumably
are taught at police college never to say man. I remember
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laughing out loud when I heard a police spokeswoman who was being interviewed on television refer to the unidentified suspect in a sexual
assault as a gentleman.
Not long ago a similar remark was attributed
(by the CBC Web site) to the “co-owner” of a
school where a man had allegedly molested a
little girl in the washroom: “Our administrative
secretary grabbed the gentleman [i.e., the suspect] when he was coming out of the washroom.”
The use of gentleman in a letter to the lovelorn
column in the toronto star is equally incongruous: “Later in the evening she got stand-offish and didn’t speak to me; instead she talked to
another gentleman at the bar.” It’s hard to imagine that the writer was really thinking of this
potential rival as a gentleman. The possibility
that gentleman was inserted by the columnist
makes it no more appropriate in the context.
gentleman, however, is not the only replacement for man. The letter quoted above begins
with the words: “I’m a single male, never been
married, never been in a serious relationship.” It
seems bizarre for a man to refer to himself as
a male rather than as a man—and I’m sure it’s
something new—but its frequent use in companions-wanted ads (which presumably have not
been edited) suggests that it must be common.
Sometimes an incorrect use of male finds its
way into print, as in this notice on a washroom
door at the St. Lawrence Market: “There are
more male and female washrooms by the east
doors.” Perhaps the writer couldn’t decide between ladies’ and women’s and between men’s
and gentlemen’s. In view of the muddled use of
those words, one can sympathize. Or perhaps he
or she didn’t know how to use apostrophes and
found a way to avoid them altogether.

It is interesting that male as a noun has fewer
derogatory connotations than female. I’ve
always remembered reading in the news report
of a trial that the judge had forbidden the use
of female in his courtroom. Presumably the accused or the witnesses had been using the word
in a derogatory sense.
Since the confusion about how to refer to men
and women is found mainly in the spoken language, editors are not likely to encounter it often
in their work; however, it is something we hear
almost every day. 
Freya Godard has been a freelance editor and writer
for more than 25 years. She also does indexing and
translating and has taught many EAC seminars. In
a previous career she taught high school French and
German, adult ESL, and university-level writing. Freya
lives on Toronto Island. godard@colcomm.ca 416 2140183, ext. 13
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TekTips
Tips, tricks, and cool Web sites

Learn everything about your daily
cup of coffee—from harvesting to brewing.
www.coffeeresearch.org
Speed up the time it takes for Windows
XP to display your icons in My Computer.
In My Computer, choose Tools > Folder
Options. Select the View tab and deselect the
Automatically Search for Network Folders and
Printers check box
set your own default working folder
in Microsoft Word (versions 97–2003). Whenever
you choose Save As or Open, Word usually
opens the My Documents folder by default in
the dialogue box. You can change this by choosing Tools > Options > File Locations. Select
Documents from the File Types box and click
Modify. In the Modify Location dialogue box,
open the folder you wish to set as your default.
Click OK and then OK again
In Outlook Express, you can change a
message priority to high so that it stands out
in your Inbox. Right-click the message, choose
Options. Select High from the Importance dropdown list in the Message Settings area. Close and
save your changes
use your phone as a reminder service
with Rminder. With a free account, you can send
eight reminders per month with a weekly limit of
two. For USD$9 you can send up to 60 reminders.
Type what you want the reminder to say, schedule the call, then enter your phone number. The
phone will ring and you will hear your reminder.
www.rminder.com
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save a snapshot of web pages you want
to read later and send it to an e-mail address
by signing up with Toread.cc. You can also use
Tomobi to convert your Toread Web page into
text-only, and send it to your mobile device.
http://toread.cc
contemplate the universe in all its
glory by watching this cute sing along
http://dingo.care2.com/cards/flash/5409
/galaxy.swf

In the news

Is “bestselling” all about making money for the publisher?
Read why The Times’ Fay Weldon thinks “bestselling” may
be a bad thing and why Scott Pack disagrees with her.
Read more here

In the beginning was the word. And the word often started
out like this: “Hey, guess what I heard about Og? Don’t tell
anyone, but I think Og and Ogga are splitting up!” Read
Read more here
why mobile gossip is good for us.

Have you ever been scolded for abusing a book? Read
Ben Schott’s own experience in “Confessions of a Book
Abuser.” Read more here
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Reflections on writing
Book review of Writing Life: Celebrated Canadian and International
Authors on Writing and Life by Noreen Shanahan

Constance Rooke begins
Writing Life with the “Death of the Author.”
“When people in university English Departments were first
discussing with great enthusiasm the Death of the Author—a death,
reported by Roland Barthes, that accorded new power and freedom to
critics and readers working on the author’s textual remains—I rebelled.
“I didn’t want the power to be taken away from writers and given to me. I didn’t
want the author to be dead, or exiled from the relationship between reader and text;
for me the idea of the writer as a human being—the individual, living or dead, who
wrote these words and was mysteriously present in them—was the person who
wrote the book; I read alone, and the writer writes alone, but the words connect.”
When I first worked my way through this densely packed book of authors’ reflections on writing, I began a kind of “Where’s Waldo” search for the missing editor;
a search for between-the-lines/between-the-scenes efforts of structural editors, copy
editors, and proofreaders who were missing in action—missing in the action of
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telling about writing. I counted four instances in the
text where an editor was credited as somehow being
part of the writing life.
This issue of edition flies hot off the press not
long after International Women’s Day. A significant
number of editors are women—handmaidens of the
authors, all neat and tidy in the background. It reminds me of a comment made at a recent EAC seminar: a young woman said that one of her fantasies, in
embarking on a freelance editing career, is to see her
name acknowledged by an author in print.
Writing Life is a fundraising tool for PEN Canada.
McClelland & Stewart contributed its resources in
publishing it; suppliers and printers donated their
services; and the writers generously donated their
previously unpublished contributions. It contains
49 essays by authors who have been asked to freely
approach the topic of writing and life. The pun, says
Rooke, is intentional. Some describe “the writing life”
while others turn to “writing about life.”

Contributors include Michael Ondaatje, John Berger,
Margaret Drabble, Alice Munro, John Ralston Saul,
Margaret Atwood, Susan Musgrave, Lisa Moore, and
Shyam Selvadurai. Contributors run the gamut of
publisher, historian, past director of Canada’s most
celebrated literary festival, writers of memoirs, biographers, playwrights, poets, and fiction writers.
David MacFarlane’s essay, “On Not Going to
a Party for Ian McEwan,” describes a familiar
New Yorker cartoon template: an (always male) writer
sits at his tiny desk going through many kinds of hell,
while his wife stands at the doorway saying things
like: “According to the Times it took Richard Nixon
seven weeks to write his book.”
McFarlane points out how critically important
that doorway is as a boundary between the writing
and the non-writing world. The former is depicted by
a bleary, bloated, unshaven husband with balled-up
paper scattered around his desk. And on the other
side of the doorway, sanity prevailed.
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Why did my friend acquiesce? Because writers
who don’t sell enough books can be dropped by
their publishers.

“There, bills were getting paid, children were being looked after, phone calls got returned, birthdays
remembered. There was toilet paper.” Again this
reminds me of the roles editors play in, well, making
sure there is toilet paper?
Here are the results of my “Where’s Waldo” search
for editors.
Marilyn Bowering’s “Famous Writers” describes
author-editor conflict—both from her own experiences and in stories she heard from other writers. She
describes once being asked to explain her metaphors.
“I considered it, too, until I saw how it flat-lined the
book. A linear death.” She also comments on how
another editor asked her colleague to change the
depiction of a main character; to make him friendlier,
more positive.
“It would be a little like changing Genghis Khan
into Elmer Fudd,” she writes. “Why did my friend
acquiesce? Because he was afraid. Because writers
who don’t sell enough books can be dropped by their
publishers; and because his editor had convinced
him that the marketplace (of the solipsistic magic
circle) would be more comfortable with a positive
view of this character.” She might be right, sadly. But
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there is a fair bit of rancour towards editors coming
out in her tone of voice.
Howard Engel wrote a riveting personal essay
about a disabling stroke that quite literally stripped
away his ability to read words on the page. “The
stroke was a poison dart that hit me where I live, in
the centre of my brain that controls the recognition
and interpretation of symbols like letters.” He was
still able to write, amazingly, but was not able to
read back his own words. Despite all odds, a text was
gradually assembled and for this he thanks an excellent core of editors including Cynthia Good, the former chief editor at Penguin, and Mary Adachi, “who
has saved my grammatical bacon down the years.”
The next mention of an editor comes in a tonguein-cheek way by Alice Munro in “Writing. Or, Giving
Up Writing.” Once I was over the shock of imagining
a world without any more Munro stories, my eye fell
upon that single word: editor. She tells us how her
latest book will be her last book. “Now it is finished—
at least I think it is, although my editors may think
otherwise…” Alice Munro clearly doesn’t forget the
handmaids of literature. She also makes an interesting comment about being an older writer.

The writing life

“So—I can quit writing, in the
interests of a manageable life.
And in the knowledge that it’s
very rare for outstanding work to
be produced in these later years,
so one or two books fewer won’t
really be anybody’s loss.” There
is, for me, a deep sadness in this. I’m just not sure if
the greater share of that sadness belongs to me, or to
Alice Munro, or perhaps to her editors.
The most generous and complex depiction of the
writer-editor relation comes from Anna Porter’s
piece on Farley Mowat called “The Master Storyteller.”
She writes about first meeting Mowat in 1970, when
she was working as “some sort of junior editorial
busybody,” at McClelland & Stewart. Their professional relationship painstakingly grew from discord
to devotion. “Predictably, we fought and argued,
yelled and harangued each other, more or less as Jack
McClelland had intended we would. I’m not sure why
that resulted in a kind of friendship, but Jack had
been fairly certain it would and he knew Mowat well.”
My search for “editor” as a participant in the
writing life ended here. And then I flipped back
to the beginning of the book and found ample

appreciations in Constance
Rooke’s introduction. As an
editor, she knows editors. Here
is her thanks writ large.
I want to express my gratitude
here to Amber Wilson, who gave
me invaluable logistical help
and astute editorial advice… Profound thanks go to
Doug Pepper, President and Publisher, for his strong
support of this project, and to Ellen Seligman, Publisher
(Fiction), for her unfailing support and expert guidance
in the development of all three PEN Canada anthologies.
I am grateful to copy editor Jenny Bradshaw and to
all those involved in production, design, sales, and
publicity for their energy and expertise. Finally, it would
be impossible for me to give sufficient thanks and
recognition to Anita Chong, who worked with me on
this anthology from its beginnings through to the end.

And now go to your local bookstore, slap your coins
on the counter (all proceeds go to PEN and it’s a
tax deduction) and buy this book. Enjoy reading it,
through your editorial lens and your insatiable hunger for fine words about (the) writing life. 
Noreen Shanahan is Public Relations Chair,
EAC Toronto branch. toronto_br_pr_chair@editors.ca
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Networking directory
All events are in Toronto unless otherwise noted.

ART BAR POETRY
www.artbar.org

SERIES

THE CENTRE FOR REFORMATION & RENAISSANCE
STUDIES (UNIVERSITY OF TORONTO) (CRRS)
www.crrs.ca

ATKINSON COLLEGE, YORK
www.atkinson.yorku.ca

BOOK PUBLISHERS’
www.bppa.ca

UNIVERSITY
EAST END WRITERS’
www.samcraw.com

GROUP

PROFESSIONAL ASSOCIATION
GREY BORDERS READING
www.greyborders.com

CANADIAN AUTHORS ASSOCIATION—
TORONTO BRANCH
www.canauthorstoronto.org

SERIES

HUMBER SCHOOL OF CREATIVE
PERFORMING ARTS

AND

www.creativeandperformingarts.humber.ca

CANADIAN BOOKBINDERS
(CBBAG)

AND

BOOK ARTISTS GUILD
INTERNATIONAL ASSOCIATION OF BUSINESS
COMMUNICATORS—TORONTO CHAPTER (IABC)

www.cbbag.ca

toronto.iabc.com

CANADIAN FEDERATION OF
www.federationofpoets.com

POETS (CFP)
INTERNATIONAL READINGS
HARBOURFRONT CENTRE

AT

www.readings.org

CANADIAN INFORMATION PROCESSING SOCIETY
(CIPS)
www.cipstoronto.ca

CANADIAN SOCIETY OF CHILDREN’S AUTHORS,
ILLUSTRATORS AND PERFORMERS (CANSCAIP)
www.canscaip.org
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MAGAZINESCANADA.CA
www.magazinescanada.ca
MUNK CENTRE FOR INTERNATIONAL STUDIES,
UNIVERSITY OF TORONTO
www.utoronto.ca/mcis

Networking directory

PAGES BOOKS & MAGAZINES
www.pagesbooks.ca

TORONTO WOMEN’S BOOKSTORE (TWB)

PROFESSIONAL LEARNING CENTRE, FACULTY OF
INFORMATION STUDIES, UNIVERSITY OF TORONTO

THE WRITERS & EDITORS NETWORK (WEN)

www.womensbookstore.com

www.wenetwork.org

www.plc.fis.utoronto.ca

PROFESSIONAL WRITERS ASSOCIATION
—TORONTO CHAPTER

OF

CANADA

THE WRITERS’ CIRCLE
(WCDR)

OF

DURHAM REGION

www.wcdr.org

www.pwactoronto.org

WRITERS’ TRUST OF CANADA
www.writerstrust.com 
SOCIETY FOR TECHNICAL
www.stctoronto.org

COMMUNICATION (STC)

TO LIVE

WITH CULTURE
www.livewithculture.ca

TORONTO CENTRE FOR THE BOOK
(UNIVERSITY OF TORONTO)
www.library.utoronto.ca/tcb

TORONTO PUBLIC LIBRARY
www.torontopubliclibrary.ca

TORONTO WRITERS’ CENTRE
www.writerscentre.ca
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Bon mots
The lighter side of life

S

herlock Holmes and Dr. Watson go on a camping trip. After a good
dinner and a bottle of wine, they retire for the night and go to sleep.
Some hours later, Holmes wakes up and nudges his faithful friend.
“Watson, look up at the sky and tell me what you see.”
“I see millions and millions of stars, Holmes,” replies Watson.
“And what do you deduce from that?”
Watson ponders for a minute.
“Well, astronomically, it tells me that there are millions of galaxies and potentially
billions of planets.
“Astrologically, I observe that Saturn is in Leo.
“Horologically, I deduce that the time is approximately a quarter past three.
“Meteorologically, I suspect that we will have a beautiful day tomorrow.
“Theologically, I can see that God is all powerful, and that we are a small and
insigniﬁcant part of the universe. What does it tell you, Holmes?”
Holmes is silent for a moment, then he says, “It tells me someone has stolen
our tent.” e
(attributed to Write101.com)

❝

Editing is the same as quarrelling with writers—
same thing exactly. — Harold Wallace Ross
(1892–1951), American journalist and founder of
the New Yorker magazine
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❞

